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Mosart Web Applications are value-adding utilities and plugins that simplify working with Viz Mosart. They are 
not part of a standard Viz Mosart delivery.
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1 Getting Started
1. Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/

by navigating to /products/VizMosart/Latest Version/WebApplications/.

2. Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

The web applications that will be installed are listed.

3. Click Install.
Any previously installed version of the Mosart Web Applications is automatically upgraded. All 
configurations and preferences are retained and you complete the installation by clicking Finish.

4. After successful installation, the Mosart Web Applications Configuration Tool displays, together with a 
desktop shortcut for quick access.

Note: If upgrading, make sure an existing instance of the Mosart Web Applications Configuration Tool is 
not open.

Info: The Installer places these services and applications on the target machine:
1. Mosart Web Applications: A Windows service that serves the Mosart Web Applications.
2. Mosart Web Proxy: Caddy2 bundled within the Mosart Web Apps installer, running as a Windows 

service.
3. Mosart Web Applications Configuration Tool: A desktop web application for configuring and 

launching the web applications.
4. The set of Mosart Web Applications listed on the Installer.
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5. From the left panel, select one of the following:

App Launcher

App Configuration

Server Configuration

User Guides

 If your system is already configured, click App Launcher and select from:
NRCS Plugin
Timing Display
Rundown Viewer
Showmaker (Early Access)
Template Editor (Early Access).

 If this is your first running of the Configuration Tool, you must make some one-time configurations,
as described in section Mosart Web Applications Configuration Tool.

1.1 User Guides
Links to a recent version of the documentation.
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Tip: The onboard descriptions are often early drafts. For latest documentation, visit the online resources at 
the Viz Mosart Documentation Center.
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2 Related Documents
 Viz Mosart User Guide: Operating Viz Mosart in a live production.
 Viz Mosart Administrator Guide: Configuring and customizing Viz Mosart and pre-production show design.

For more information about all of the Vizrt products, visit:

 www.vizrt.com
 Vizrt Documentation Center
 Vizrt Training Center
 Vizrt Forum
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3 Feedback and Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback and/or 
suggestions, please contact your local Vizrt customer support team at www.vizrt.com.
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4 Configuration Tool
 App Configuration
 Server Configuration
 Mosart REST API

 API Documentation
 HTTPS Usage Notes

 Certificate Requirements
 Certificate Installation

 Authentication
 Prerequisites
 Setup
 Provider-specific Newsroom Authentication

 Troubleshooting

The Configuration Tool enables rapid setup and management of all your the Mosart Web Applications.

 If your setup is already configured, use App Launcher for NRCS Plug, Timing Display, Rundown Viewer
and Showmaker.

However, on first run, you must perform all necessary one-time setups for all the Mosart Web Apps from two menus:

 App Configuration
 Server Configuration.
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4.1 App Configuration
 NRCS Plugin
 Showmaker (Early Access)
 Template Editor (Early Access)

Settings here are needed when you:

 Use the NRCS Plugin or Showmaker (Early Access) for the first time.
 Installed the Mosart Web Apps bundle on a separate server to the Viz Mosart server.

4.1.1 NRCS Plugin

To configure the NRCS Plugin
1. First perform the Getting Started (Installation) procedure.
2. Select App Configuration and click NRCS Plugin.

3. From the NRCS type drop-down menu, select your newsroom system type.
4. (If iNEWS is selected NRCS type, ignore this step)

Enter Mos ID.
This is a mandatory field if you select NRCS type ENPS, Octopus or Other. 
To find your Mos ID

a. In the Manus Administrator console, type settings.
For more details, see the Viz Mosart Administrator Guide, section Manus Administrator > Settings Editor MOS > 
NRCS Configuration.

5. Back in the Web Apps Configuration Tool App Configuration page for the NRCS Plugin, in section ACCESS 
MOSART TEMPLATES, specify the location of your Viz Mosart templates.
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This can be either
a. Local: By default, this is a local folder C:\channeltemplates. The tool will automatically scan for three 

files:
 channeltemplates.xml
 avconfig.xml
 newsroomsettings.xml

If successfully identified, a green validation message is displayed.

b. A network folder: When your template folder is on a network drive
i. Click Choose folder and navigate to the target folder.

ii. Ensure the network folder has adequate permissions.
c. Database: If template details are stored in a database, enter host access and authentication details.
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6. Click Save.

4.1.2 Showmaker (Early Access)
Showmaker can run standalone, as a rundown (running order) creation tool.

If you wish to use Showmaker with Viz Mosart, follow these instructions, that depend on whether Showmaker is 
installed on the Viz Mosart server or another machine.

MOS COMMUNICATION SETTINGS
The following configurable properties define the communication.

Property Description

NRCS ID This is the Newsroom System ID for Showmaker. Set this ID on any MOS-
enabled device to establish communication with Showmaker.

For Viz Mosart, this value must be set in Viz Mosart Manus 
Admin. Default: SHOWMAKER.MOS.

MOS Device ID This is the ID of a MOS device configured to communicate with 
Showmaker. For Viz Mosart, copy this value from Manus Admin settings 
> MOS section . Default: MOSART.MOS.SHOWMAKER.

Note: To complete the NRCS Plugin setup, you will also need to visit the Server Configuration page, 
presented below.
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Property Description

MOS Device URL The URL for connecting to a MOS device.
For Viz Mosart server, the URL is ws://mosart-server-host:10540/mos/
mosartsocket.
The port in the URL (10540) is the MOS lower port configured in the 
Settings menu of Manus Admin, under the MOS section. Default: ws://
localhost:10540/mos/mosartsocket.

To establish communication between a MOS device and Showmaker
There are two alternative, depending on your network type.

 Showmaker is installed on the same server as Viz Mosart.
 Showmaker is installed on separate server to Viz Mosart.

Showmaker is installed on the same server as Viz Mosart

1. If you are running Showmaker on the same server as the Viz Mosart server, the Configuration Tool provides a 
way to automatically configure Viz Mosart to establish communication with Showmaker.

2. From the App Configuration page, under Showmaker, tick View advanced options and review settings. If 
necessary, adjust the default values as described in the table above.

3. In the same App Configuration menu for Showmaker, click Push Settings to Manus Administrator.

4. A warning message reminds that Manus Administrator shall not be running at this point.
Ensure Manus Admin is closed before continuing.
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5. To complete the action, click Confirm.

Showmaker is installed on separate server than Viz Mosart

If you are running Showmaker on another server than the Viz Mosart server, Viz Mosart must be manually setup to 
connect to Showmaker.

1. Review the advanced options and, if necessary, adjust the default values as described above.
2. In the App Configuration menu for Showmaker, click View Settings for Manus Administrator.
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3. On the Viz Mosart server, in the Viz Mosart Manus Admin console, type settings
4. From the Settings menu that appears, navigate to the section MOS.

5. Configure the MOS settings as presented in the pop-up menu Settings for Manus Administrator (shown 
above) in the Web Apps Configuration Tool.

6. Click Save.

Assets integrations settings
If you use either Viz Pilot or Viz Flowics to provide assets for your show, you need to configure some one-time 
settings.

Viz Pilot

1. If you will run Showmaker with assets from Viz Pilot, click VIZ PILOT GRAPHICS AND ELEMENTS.
2. By following the on-screen information (  icon), provide values for

a. Application URL (where Viz Pilot Edge is running)
b. MOS Plugin ID.

3. Click Save.

Viz Flowics
1. If you will run Showmaker with assets from Viz Flowics, click VIZ FLOWICS GRAPHICS.
2. Ensure you have your Viz Flowics (cloud application) credentials to hand.
3. By following the on-screen information (  icon), provide values for

a. Integration token
b. Application URL (where Viz Flowics is running)
c. MOS Plugin ID.

4. Click Save.

Note: To complete the Showmaker setup, you will also need to visit the Server Configuration menu, as 
described below.
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4.1.3 Template Editor (Early Access)
 Please refer to the section Setup and Administration of Template Editor.

4.2 Server Configuration
 Proxy Setup Method
 Automatic Proxy Setup
 Manual Proxy Setup
 Enabling Updates from the Mosart Server over HTTPS
 Mosart API Access
 Video Clips
 Template Editor

Most settings here are needed when you

 Install the Mosart web Apps bundle on a separate server to the Viz Mosart server.
 Move the Web Apps to a different server.
 Need to define the Viz Mosart backup server.
 Need to set up HTTPS across the Mosart network.

4.2.1 Proxy Setup Method
Mosart Web Apps communicates through a proxy server that must be configured.

You can choose to use the onboard proxy bundled with Viz Mosart or an external proxy.
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Click either

 Automatic proxy setup - to use the onboard proxy server (Caddy v2).
or

 Manual proxy setup - to use your own proxy server.

4.2.2 Automatic Proxy Setup

To set up the automatic proxy server 
1. You can use the onboard proxy web server where configurations are automatically generated based on the 

settings displayed on the Server Configuration page.
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2. All default settings are already pre-filled and no further action should be necessary.
However, if you need to change any values see the settings below:

a. PROXY WEB SERVER
i. Address: Hostname or IP address of the machine where the Mosart Web Applications are 

installed. The system attempt an auto-detect. If the FQDN is required (for example, by a 
certificate), provide this instead.

b. MOSART MAIN SERVER
i. Address: By default, this field will contain the address of the Mosart Web Applications. Please 

enter the hostname, IP address, or FQDN of the main Viz Mosart server if located on another 
machine.

c. MOSART BACK-UP SERVER
When running Viz Mosart with a backup for redundancy, provide the backup server address.

i. Select the MOSART BACK-UP SERVER check-box.
ii. Address: Enter the hostname, IP address, or FQDN of the backup Viz Mosart server.

3. Click Save.

HTTPS

In this Automatic proxy setup, selecting HTTPS automatically configures both the Mosart Web Applications and the 
Mosart Web Proxy (Caddy). The hosts included in the certificate are validated against the web proxy server defined 
in the field WEB PROXY SERVER >  Address.
For the Mosart Web Proxy, the configured private key is used to automatically generate an unencrypted PEM-format 
required by Caddy, which is saved in C:\ProgramData\Mosart Medialab\Mosart Web Apps .

4.2.3 Manual Proxy Setup
You can use an external proxy server, but it must be manually configured.
If the external proxy server is configured with HTTPS, you must also set up HTTPS for the Viz Mosart Web 
Applications and Mosart servers.

To set up a proxy server manually
1. From the Server Configuration page, select Manual proxy setup.

Note: If the Mosart Web Proxy and the Mosart Web Applications are configured with HTTPS, you must also 
configure HTTPS for the Mosart servers (Main and Backup, if applicable).
See Enabling Updates from the Mosart Server over HTTPS.

Tip: You can examine the Caddy file generated when Automatic proxy setup is selected to understand how 
to set up an external proxy. This Caddy file resides at C:\ProgramData\Mosart Medialab\Mosart Web Apps.

Copyright © 2025  Vizrt                                                          Page  22



Viz Mosart Web Applications -  2.5

2. Under section PROXY WEB SERVER in field URL, enter the URL address to the external proxy server. This 
must be a valid web URL starting with http or https.

HTTPS
In Manual proxy setup, the certificate is only for the Mosart web server. The hosts included in the certificate 
are validated against the Mosart web server address field (under the HTTPS section).
If you are using HTTPS, continue with steps 3 to 5 below.

3. Select the HTTPS check-box and follow the onscreen guidelines ' '.

4. Web Server Address: The IP or the hostname of the Viz Mosart web server. The system attempt an auto-
detect. If the FQDN is required (for example, by a certificate), provide this instead.

5. Certificate file: The certificate in encrypted PEM format. If FQDN is specified in the certificate file, the Mosart 
web server address must also be a FQDN.

6. Click Save.
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4.2.4 Enabling Updates from the Mosart Server over HTTPS
If using HTTPS with the NRCS Plugin, Rundown Viewer or Timing Display, you need to configure the Mosart Remote 
Dispatcher Service to allow continuous rundown updates between the Viz Mosart server and the web applications.

To turn HTTPS on in Mosart Remote Dispatcher Service
1. On the Viz Mosart server machine, copy the file C:\Program Files (x86)\Mosart Medialab\Mosart 

Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart 
Medialab\ConfigurationFiles.

2. Fill in the following fields:
 SignalRUseHttps: true
 SignalRCertificatePath: <Certificate File for Viz Mosart server>
 SignalRCertificateKeyPath: <Private Key file for Viz Mosart server>
 SignalRCertificatePassword: <Password as configured for the private key>

3. Restart the Remote Control Service.

4.2.5 Mosart API Access

The Authorization Key entered here is essential for accessing methods provided for special features. For example, 
clip search utilities in the NRCS Plugin request lists of clips from the Viz Mosart Media Administrator. This requires a 
special secure call to the Viz Mosart server through the Mosart Remote Control Service (RCS). RCS contains the 
special key-value item in its configuration file RemoteDispatcherServiceConfig.xml, where the RestApiKey entry is 
the value that must be entered here as Authorization Key.
See also: Mosart REST API (below).

4.2.6 Video Clips
This setting affects only Timing Display. Video clips (PACKAGE templates) can be presented with various details.

 Select what to display from the dropdown menu.
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4.2.7 Template Editor
By default, the Template Editor is not available. Select the checkbox to enable it.

4.3 Mosart REST API
Mosart Web Applications can now be used as a proxy to call the Mosart REST API on the current active server.

4.3.1 API Documentation
 With Web Apps running, you can browse the API documentation at

http://[web-apps-machine:port]/mosart/swagger.

4.4 HTTPS Usage Notes
When Mosart Web Applications are configured with HTTPS, all communication between clients, proxy servers, and 
content servers must be secured. This includes the following components:

 Mosart web clients (Rundown Viewer, NRCS Plugin, Timing Display etc.).
 Mosart web server (Mosart Web Applications service).
 Proxy server (internal, i.e. Mosart Web Proxy service, or external).
 Mosart Server (Mosart Remote Control Service).
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4.4.1 Certificate Requirements
 Type: X.509 certificates.
 Format: PEM-encoded certificates and private keys.

 For the Mosart Web Proxy (Caddy), the key must be in unencrypted PEM format, which is 
automatically generated by Mosart from the provided encrypted key file.

 Encryption: Private keys must be encrypted and provided with the corresponding password. You can verify 
if the key is encrypted by opening it in an editor and checking that it starts with "-----BEGIN ENCRYPTED 
PRIVATE KEY-----" and ends with similar text.

 Host coverage: The certificate must include the host where the Mosart Web Applications are installed. The 
hosts provided in the Mosart Web Config tool will be validated against the certificate (case sensitive). If the 
hosts in the certificate are the Fully Qualified Domain Name (FQDN), then the hosts provided in the Mosart 
Web Config Tool must be the FQDN as well. If the same certificate and key files are used across all Mosart 
components (Mosart Web server, Mosart web proxy, Mosart server main, Mosart server backup), the 
certificate must specify all relevant hosts or their FQDNs.

4.4.2 Certificate Installation
Certificates must be trusted on any machine where Mosart Web Apps are used. Ensure the certificates are installed 
on:

 Mosart Web Applications / Mosart Web Proxy.
 Any Mosart Server.
 Any machine running Mosart web clients.

If the certificate is not installed on a machine using a Mosart Web App, the browser will warn of insecure 
connection, suggesting you proceed at your own risk. However, if the Mosart Web App is integrated as a plugin 
within other applications (for example, into ENPS), there may be no warning, and you experience issues like a blank 
page.

4.5 Authentication
Viz Mosart Web Applications supports authentication using OpenID Connect.

4.5.1 Prerequisites
 HTTPS has to be configured to use authentication.
 You need a third party OpenID Connect authentication service, such as Keycloak, Okta, or Microsoft Entra ID.

(If you are already using Viz One you should already have a Keycloak authentication server).

4.5.2 Setup
1. Create a new Client/App registration in your authentication provider and add a Client Secret.

a. Keycloak guide
b. Entra guide
c. Okta guide.
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2. Your authentication provider must provide
- Issuer URL/Authority URL
- Client ID
- Client Secret.

3. Open the Mosart Web Application Configuration Tool and select Server Configuration.
4. Enable the Authentication check-box and enter the details obtained at step 2, above.

5. Click Save.

Authentication is now enabled.

4.5.3 Provider-specific Newsroom Authentication

iNEWS
Authentication will only work if you are using the NRCS plugin with the NRCS plugin iNEWS Client Addon.
Authentication will not work by hosting the Plugin as a regular HTML plugin.

ENPS
To use the NRCS plugin with ENPS, first add your ENPS server machine to the list of allowed frame-ancestors in the 
Content Security Policy on your Authentication Provider.

Typically this is a simple edit of the Content Security Policy:
From

frame-src 'self'; frame-ancestors 'self'; object-src 'none';

to

frame-src 'self'; frame-ancestors 'self' {Your ENPS server}; object-src 'none';

 Keycloak: Go to Realm Settings > Security Defenses.
 Okta: Follow this Okta guide.
 Entra: Since you cannot edit the Content Security Policy for Microsoft Entra ID, authentication with Entra ID 

for the NRCS plugin in ENPS is not supported.
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Octopus
NRCS plugin authentication is not currently supported with Octopus.

4.6 Troubleshooting
See section Troubleshooting.
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5 NRCS Plugin
The NRCS Plugin is an effective drag and drop tool for reliably adding Viz Mosart template instructions to an NRCS 
story.

 Working with the NRCS Plugin
 NRCS Plugin in Pilot Edge
 Setup and Administration

Note: For news-breaking details on the Mosart NRCS Plugin, please refer to the Mosart Web Apps Release 
Notes for your version of Viz Mosart at the Vizrt Documentation Center. 

Tip: This document contains animated graphics. If you are viewing as PDF, we recommend browsing the 
web version.
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5.1 Working with the NRCS Plugin
The NRCS Plugin delivers the functionality previously provided by the legacy Viz Mosart ActiveX Plugin.

 User Operations
 Getting Help
 Error Handling
 API Documentation

5.1.1 User Operations
 Searching for a Template
 Modifying a Template
 Adding Template Details to the NRCS
 Refreshing Template Changes
 Optimizing Your NRCS Plugin Workspace
 Copying the MOS Object Details
 Modifying Existing MOS Objects

Searching for a Template
Locate a template by selecting a template set and typing a variant or template type in the Search box. Auto-suggest 
will display search results as you type. If the application is configured to use a template database, you will also need 
to select a gallery. If the application uses templates from a file, there will be only one gallery, so no gallery selection 
is required.
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Text highlighting helps with pinpointing search results:

Modifying a Template

To modify production characteristics
Variables

 Click on a template in the search listing. Properties (called Variables) that have been added to the template 
(using Viz Mosart's Template Editor) appear to the right.

 You can temporarily override any defaults, and add new variables.
For example, in a Video Effects template, you may wish to change the source of the second input:

Note: Variables are called Newsroom tags in the Viz Mosart Template Editor.
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Transitions

 The Transition field initially displays the default transition type. This value indicates the most significant 
template behavior.

 You can temporarily modify this transition type, and then later restore the default transition (as originally set 
in the Template Editor).
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Adding Template Details to the NRCS

 Drag and drop the template into the required location of the story slug.

Note: You can restore the default transition by clicking the Reset button.
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 In a MOS-based NRCS, in addition to drag and drop, the Add to Story button can be used to add a template 
to a story.

Refreshing Template Changes
If changes are being made to the active template set (by another operator using Viz Mosart's Template Editor), click 
the Refresh button from Settings to get the latest template changes.

Note: The names of both the gallery and the template set of your selected template are always included 
with the MOS object that you store as a story item in your NRCS rundown.
Any future use of this NRCS MOS item will always point to exactly the same template (same 
gallery, template set and template name) when it displays in the Mosart NRCS Plugin.
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Optimizing Your NRCS Plugin Workspace

Collapsing the Type listing
You can save some screen space taken by the Mosart NRCS Plugin by collapsing the Template Types panel: 

 Click the Collapse button.

 You can customize the number of columns to adjust the template list size. Selecting the last option will 
automatically fit the number of columns to the window size.
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Scaling the View
As the Plugin is a web application, you can set your preferred scale by zooming in and out.

 For most browsers, you can use the shortcut Ctrl+mouse wheel.

Copying the MOS Object Details
You can work with the template's raw MOS data by first copying it to your PC's clipboard.

 From a selected template, click Copy MOS icon.
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Modifying Existing MOS Objects
Your rundown will usually contain slugs with MOS objects that have been created with either this Mosart NRCS 
Plugin or the legacy component, Viz Mosart ActiveX.

To modify an existing MOS object
1. On the selected rundown story, double-click the slug or grommet that holds the story's MOS object.
2. The corresponding Viz Mosart template, along with control details such as newsroom tags, crosspoints, 

transitions, and timings, is displayed in the Viz Mosart NRCS Plugin.
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Make the modifications directly in the Mosart NRCS Plugin window.
3. When finished editing, apply the changes. In the iNews newsroom system, use the OK, Apply, or Cancel

buttons (specific to iNews) to modify and close, modify without closing, or cancel the editing, respectively. In 
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a MOS-based NRCS, the plugin includes its own buttons to modify or cancel the editing.

You cannot modify a MOS object that refers to a not-found Viz Mosart template.
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To modify MOS objects created with the Mosart NRCS Plugin

 MOS objects created by the Mosart NRCS Plugin include references to the gallery name and template set
name.

 If your rundown item refer to a template set that cannot be found in the gallery, the Mosart NRCS Plugin 
checks the active gallery and template set for a corresponding template. This valid reference is then applied 
to the MOS object, when you click Update (in MOS-based NRCS) or OK/Apply (in iNews) on the replacement 
template.

The active Gallery and/or Template set name may automatically change if your selected MOS object 
references a different gallery/template set. You are always notified if this happens.
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 Alternatively, you can manually search gallery/template sets to locate a similar template.
After editing and applying the changes, the new (active) gallery and template set name are stored in your 
rundown MOS object.

To edit MOS objects created by ActiveX
When working with MOS objects that were created with Viz Mosart's legacy NRCS Plugin (Mosart Active-X) the 
currently selected gallery name and template set name will always be used as template source.
In the Plugin, ensure to select correct gallery and template set before you start editing.

5.1.2 Getting Help
The NRCS Plugin documentation is continually updated and available online. This includes both this User Guide and 
the Release Notes.
You can also send your feedback directly to the Mosart NRCS Plugin design team.

 Click the Settings icon at the top right:

5.1.3 Error Handling
While navigating through templates, if there are exceptional conditions, the Mosart NRCS Plugin displays an error 
message.
See the example below:

Copyright © 2025  Vizrt                                                          Page  41



Viz Mosart Web Applications -  2.5

Please refer to the Troubleshooting or contact Vizrt Support if you encounter any error messages.

5.1.4 API Documentation
The NRCS Plugin also installs the Mosart REST API. Details about the API endpoints are provided in the open API 
documentation (Swagger Open API (OAS) documentation) at:
http://localhost:55142/docs

Examples

 Retrieve all galleries:
http://localhost:55142/api/v1/galleries
(A list of gallery names is obtained)

 Choose a gallery name from the list obtained in the previous example. For the sake of this example, assume 
that Local was on the list. (If not, choose some other gallery name.)
To retrieve the template sets for the gallery named Local:
http://localhost:55142/api/v1/galleries/Local/templatesets.

Note: Replace localhost with the IP address of the computer on which the API is installed.
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5.2 NRCS Plugin in Pilot Edge
If you are using the Pilot Edge version 3.0 or later, you can host the NRCS Plugin within the Pilot Edge Plugin.

5.2.1 Hosting NRCS Plugin within Pilot Edge
 Set Up
 Working with the Mosart NRCS Plugin in Pilot Edge

Set Up

To activate the NRCS Plugin in Pilot Edge
1. Open your Pilot Data Server.
2. In the menu bar, click Settings.

3. On Pilot Settings at the top right, right-click and select Add New Optional Parameter.

4. In the Name field, add the name moseditor_mosart_url.
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This now appears under the Name column:

5. Under the Value column, enter the URL to your Mosart NRCS Plugin.

Tip: You can fetch this address from the Configuration Tool by selecting App Configuration > NRCS 
Plugin and copying the value of Preview URL.
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6. At the top left, click Save.

Working with the Mosart NRCS Plugin in Pilot Edge
1. In your newsroom system, open the Pilot Edge Plugin.

A new tab Mosart appears at the top.
2. Click the tab to open the Mosart NRCS Plugin.

3. To add a Mosart item to your rundown, select the item and drag in the Cross icon at the top right of the 
plugin.

Note: If you are using the Pilot Edge on HTTPS, the Mosart NRCS plugin must also be on HTTPS.
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For a MOS-based NRCS, the Send to newsroom system option is also available:

4. To edit an added item, Pilot Edge automatically opens the NRCS Plugin inside Pilot Edge. In the iNews 
newsroom system, use the OK, Apply, or Cancel buttons (specific to iNews) to modify and close, modify 
without closing, or cancel the editing, respectively. In a MOS-based NRCS, the Pilot Edge plugin includes the 
Update in newsroom system button.
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5.3 Setup and Administration
This section describes essential post-installation configurations, usually performed by a system administrator.

 Setting up the NRCS Plugin
 Optional Server Setups

 Support for Main/Backup Connection
 Support for HTTPS

 Verifying the Mosart Installation
 Hide Effects from Users
 Integrating with an NRCS

 ENPS
 iNEWS
 Octopus
 OpenMedia
 Showmaker

 Troubleshooting

5.3.1 Setting up the NRCS Plugin
There is a standard setup that must first be followed. Please refer to the configuration procedure in section NRCS 
Plugin. 

5.3.2 Optional Server Setups

Support for Main/Backup Connection

 If you have a backup server for redundancy, you will need define the environment in the menu Server 
Configuration.

Support for HTTPS

 If you are using HTTPS, you will need define the environment in the menu Server Configuration.

5.3.3 Verifying the Mosart Installation
1. After following the mandatory App Configuration and Server Configuration procedures, a background 

Windows service, Mosart REST API (a combination of the REST API and the NRCS Plugin) starts.
2. You can check that the NRCS Plugin is accessible by either:

a. In the Configuration Tool, click App Launcher > NRCS Plugin.
or

b. following the URL next to the Copy button.

Note: Make sure to execute all instructions, including the one-time edits to the Mosart Remote Dispatcher 
Service.
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4. To complete the integration, configure the NRCS side, according to the appropriate NRCS as described in 
section Integrating with an NRCS below (where you will use the copied URL). 

5.3.4 Hide Effects from Users
In some production situations, there may be an effect recalled from specific templates, that should only be run 
under specific circumstances (for example, on an ME row).
Unintentionally selecting such an effect from the NRCS plugin (or the Viz Mosart GUI) can give unplanned on-air 
consequences.

To hide an effect from the user

1. On the Mosart server open AV Automation.
2. Navigate to A/V Setup > Effects.
3. Check Hide From User to prevent the effect displaying in the NRCS Plugin (and the Viz Mosart GUI 

Transition panel).
4. Save.
5. Refresh the NRCS Plugin.

5.3.5 Integrating with an NRCS
 The server-based plugin configuration described below avoids having to configure each individual 

newsroom control system (NRCS) client.
 This section assumes the Mosart NRCS Plugin has been successfully installed and set up, as described in 

section Mosart Web Applications Configuration Tool.

The NRCS Plugin supports connections to

 ENPS

The Plugin URL comprises the machine name, port number 55142, NRCS type and (when supported) Mos 
ID in the form:  http://machine-name:55142/plugin?nrcs={type}&mosid={mosid}

Info: This feature requires Mosart Web Apps version 2.5 or later.
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 iNEWS
 Octopus
 OpenMedia
 Showmaker.

You connect each client NRCS machine to the Viz Mosart server (which hosts the Mosart REST API.)

ENPS
1. In the Configuration Tool select App Configuration > NRCS Plugin and copy the value of Preview URL.

2. On the ENPS machine, navigate to System Maintenance > MOS Configuration.
3. Paste the NRCS Plugin's copied URL, similar to the example below:

Info: The URL comprises a combination of the Plugin's URL + a fixed port number and Viz Mosart's MosId
value in the form:
http://machine-name:55142/plugin?nrcs=ENPS&mosid=xxxx

 If you need to derive current MosId value, see the item To find your Mos ID.
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iNEWS
There are two possible setup routes, depending on whether your iNEWS version supports HTML5 plugins. Please 
consult the documentation of your iNEWS system to determine whether this is the case.

 iNEWS Clients with HTML5 Support
 iNEWS Clients without HTML5 Support

iNEWS Clients with HTML5 Support
1. In the iNEWS client, from the directory navigation tree, open the file SYSTEM.MOS-MAP and verify that 

between TABLE-START DeviceTable  and TABLE-END  there is a line

mosart ...
If not, add the mosart reference,
For example: mosart MosartNRCSPlugin

2. For this step and the next, please refer to Avid's MediaCentral Newsroom Management Setup and 
Configuration Guide, section Configuring Newsroom Management for HTML5 (chapter HTML5 Plugins) .
If you have at least one HTML5 plugin already defined, you can skip this step.
From Avid's Configuring Newsroom Management for HTML5, follow their setup steps 1 to 6. Please note that 
at:

 Step 3: (name of the new queue): Use the name HTML-PLUGINS, as recommended by Avid.
3. Continue with steps 7 to 10, observing these clarifications:

 Step 7: In case you skipped the previous step, the queue refers to SYSTEM.HTML-PLUGINS
 Step 9: (slug): Enter something like Viz Mosart NRCS Plugin. (This is the string that will be shown in the 

Plugins sub-menu of the Tools menu.)
 Step 10: (parameters): In the Story panel,

i. Enter 'URL = '.
ii. At that exact spot, paste the URL copied from the Configuration tool

(In the Configuration Tool select App Configuration > NRCS Plugin and copy the value of 
Preview URL)

iii. Finally, append
mosItemBrowserProgID = Mosart.ActiveX
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mosItemEditorProgID = Mosart.ActiveX

Example:
URL = http://machine-name:55142/plugin?nrcs=iNews
mosItemBrowserProgID = Mosart.ActiveX
mosItemEditorProgID = Mosart.ActiveX

iNEWS Clients without HTML5 Support
Installing the iNEWS Client Addon

For older versions of iNews without HTML5 support, you need to install a small wrapper utility, the Mosart NRCS 
Plugin - iNEWS Client Addon on each iNEWS client machine.

1. From the Vizrt FTP /products/VizMosart/Latest Version/WebApplications/
download and run the utility file MosartNRCSPlugin-iNEWSClientAddon-1.1.0.96.exe

2. From the Configuration Tool select App Configuration > NRCS Plugin and copy the value of Preview URL.

3. In Mosart NRCS Plugin - iNEWS Client Addon, paste-in the URL of the Plugin.

Info:
 The parameter mosItemPlayerProgID mentioned in the Avid document is not mandatory in this 

context.
 The URL element mosid is not required for iNEWS.

Note: If the old Mosart ActiveX opens instead of the Mosart NRCS Plugin when trying to modify/edit a 
Mosart item (by double clicking on the item), you must uninstall the Mosart ActiveX.
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Octopus
1. From the Configuration Tool select App Configuration > NRCS Plugin and copy the value of Preview URL.

2. Log-in to Octopus with Admin privileges.
3. From the sidebar, navigate to MOS Devices > Devices, select mosart and click Edit.

Note: If the old Mosart ActiveX opens instead of the Mosart NRCS Plugin when modifying a Mosart item (by 
double clicking on it), you must first uninstall the Mosart ActiveX, and then reinstall the MosartNRCSPlugin-
iNEWSClientAddon.

Info: To change the configured URL after the installer was closed, simply open a command prompt and 
execute:
"%programfiles(x86)%\Vizrt\Mosart NRCS Plugin - iNEWS\MosartNCSPlugin.exe" url "https://machine-
name:55142/plugin/?nrcs=iNews"
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4. Select the Plugins tab:
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5. Fill-in as below, and providing:
a. A unique name
b. Version
c. The URL to the Viz Mosart NRCS Plugin (copied in step (1).
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6. Setup is complete.
When editing a selected rundown, the user right-clicks for New > Create using <given name of the Plugin>
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For more details, see the Viz Mosart Administrator Guide, section Manus Administrator > Settings Editor MOS > 
NRCS Configuration.

OpenMedia
Connections to OpenMedia must be setup as a project with OpenMedia.
Please contact OpenMedia for further details.

Showmaker
See section Setup and Administration of Showmaker in this guide.

5.3.6 Troubleshooting
See section Troubleshooting.
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6 Timing Display
The Mosart Timing Display web app provides browser-based timing information for the studio control room and 
studio floor.

 Synchronizes with the active Viz Mosart rundown, it can be customized to display user-specific details.
 Supports a variety of devices.

For example an iPad or networked phone.
 Provides multiple, customized timing displays.

For example, one timing display can be running on the studio floor, connected to the in house intercom 
system. A second timing display is in the control room counting down packages, keeping the producer 
updated on the current show.

 Customizable audio countdowns.

This section describes:

 Working with TD
 Setup and Administration of TD

Note: For news-breaking details on the Mosart Timing Display, please refer to the Mosart Web Apps 
Release Notes for your version of Viz Mosart at the Vizrt Documentation Center. 
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6.1 Working with TD
 Key Features
 Operating Modes

 View Mode
 Edit Mode
 Viz Mosart Server Status
 Audio Countdown

 Distributing a Timing Display

6.1.1 Key Features
 Supports a variety of devices (for example an iPad or networked phone).
 A 24 x 24 editing grid enables rich flexibility for timer layouts.
 Each timer has a consistent and readable appearance. Available space is optimized with proportionate 

fonts.
 Rapid drag and drop of timer elements, from an intuitive list.
 Rich text formatting: Color picker + Bold + Alignment + Show label.
 Customizable audio countdown.

6.1.2 Operating Modes
For daily operations, the Timing Display runs in Working with the Timing Display#View Mode. Use Working with the 
Timing Display#Edit Mode to create or adjust the display.

View Mode
Browse-anywhere timing information in your web browser.
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In View mode you can:

 Mouse-over a timing detail for an explanation.

 Display as full screen.

 Select any other defined view of the display.

To display a Timing Display in View mode

 View Mode is the result of Working with the Timing Display#Distributing a Timing Display.
 You can also browse a Timing Display in View Mode, by clicking the View button in the menu bar.

The View Mode opens in a new tab.
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Edit Mode

To create and modify a Timing Display
You can reconfigure or create a new Timing Display with details relevant to your operation.

1. If no Timing Display editor is running in your web browser
a. From the desktop shortcut or Programs menu, start the Viz Mosart Web Applications 

Configuration Tool.
b. In the Timing Display panel, click Open.

A Timing Display editing web page opens.
2. Configure the display. For example:

a. From the Timers panel to the left, drag any highlighted timing detail into the display area.
b. From the display area, click on any timing detail and edit/delete.

c. The action Delete simply returns the selected timing detail back to the Timers selection panel on the 
left.

 
3. From the menu bar, click Save as and enter a unique, meaningful name for the display.
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Viz Mosart Server Status
Viz Mosart server status can be displayed using Connection Status field.

Status Description

Viz Mosart server is active

Viz Mosart server is idle

Manus Admin is not running or Mosart Remote Control Service 
(RCS) is not running or it is not accessible.

Viz Mosart is setup with main and backup and backup Mosart 
server has been configured in Viz Mosart Web Config Tool > 
Server Configuration.

By default, the hostname, IP address, or FQDN configured in the Viz Mosart Web Config Tool > Server Configuration
for the main and backup Viz Mosart servers will be displayed. However, in newer versions of Viz Mosart, the Server 
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Description configured on each Viz Mosart Server under Manus Admin Settings is used instead.

Audio Countdown

Prerequisites
Timing Display plays its audio files located in the folder C:\ProgramData\Mosart Medialab\Mosart Web 
Apps\TimingDisplayMedia of the host machine for Timing Display.

Each audio file that you wish to use must be placed here.
The range of supported audio file formats is dependent on the web browser you use for the Timing Display, this 
external article lists audio formats supported per browser.

To activate audio countdown in a Timing Display
1. Open Timing Display in Working with the Timing Display#Edit Mode.
2. In the menu bar at the top of the page, click Audio Countdown.

3. From the dialog window that appears, click Add Countdown.
4. In the drop-down menu under Filename, select the audio file you want to play.
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The selections are populated with audio files added to C:\ProgramData\Mosart Medialab\Mosart Web 
Apps\TimingDisplayMedia (on the machine where the Mosart Web Apps are installed).
You can also test the selected audio file by clicking the Play icon to the right of the drop-down menu.

5. In the drop-down menu under Event, select the event you want the audio file to countdown towards.
Choose from:
 - End of Current Story: Counts down to the end of the current story.
 - Start of Next Break: Counts down to the next planned break.
 - End of Rundown: Counts down to the planned end of the rundown.
 - End of Current Package: Counts down to the end of a current Package template.
 - End of Current Break : Counts down to the end of a current Break template.
 - End of Current Voice Over : Counts down to the end of a current Voice Over template.
 - End of Current Float/Adlib : Counts down to the end of a current Float/Adlib template.
 - End of Current Item : Counts down to the end of each respective Story item.
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6. Set the number of seconds Before or After the event you want the Audio file to start at.

7. Repeat steps 3 to 6 for all required audio files.
8. Click OK

To verify, start a rundown and listen that the correct audio files plays at the specified time.
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6.1.3 Distributing a Timing Display
Once you have created or modified a Timing Display, you can share it with other users on the same network.

To distribute a Timing Display
1. Create/modify the Timing Display as described in Working with the Timing Display#Creating and modifying a 

Timing Display above.
2. From the drop-down menu, select the required display.

3. From the menu bar top-right, select Copy link.

4. Share the URL with your users.

Note: If you refresh the Timing Display, you must again perform some activity on the web page before any 
audio can be played.
Simplest is just clicking on the page or pressing any keyboard key while the web page has focus. This is 
standard web browser behavior.

Note: The original Viz Mosart Timing Display, with explanation of the elements, is described in the Timing 
Display section of the Viz Mosart User Guide .

Tip:
Appearance of timing information in the Viz Mosart UI
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1. Counts the downtime to the next break.
2. Counts how much the rundown is over/under.
3. Counts down the remaining time for the current On Air template.
4. Shows the duration of the current On Air template.
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6.2 Setup and Administration of TD
 Setting up the Timing Display

 Prerequisites
 Configuration

 Optional Server Setups
 Support for Main/Backup Connection
 Support for HTTPS

 Troubleshooting

6.2.1 Setting up the Timing Display

Prerequisites

 Viz Mosart 5.0.3 or later.

 Perform the installation as described in Getting Started.

Configuration
Timing Display will work out-of-the-box if the Mosart Web Apps are installed on the same machine as the Viz Mosart 
server.

It is recommended to visit the Server Configuration page to verify proxy server connections and other security 
aspects.
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6.2.2 Optional Server Setups

Support for Main/Backup Connection

 If you have a backup server for redundancy, you will need define the environment in the menu Server 
Configuration.

Support for HTTPS

 If you are using HTTPS, you will need define the environment in the menu Server Configuration.

6.2.3 Troubleshooting
Please see section Troubleshooting.
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7 Rundown Viewer
The Mosart Rundown Viewer provides a convenient web browser view of details from the current Viz Mosart 
rundown.

 Displays the active Viz Mosart rundown.
 Summary of story timings. 
 Supports a variety of devices. For example an iPad or networked phone.

This section describes:

 Working with the Rundown Viewer
 Setup and Administration of RV

Info: For news-breaking details on the Mosart Rundown Viewer, please refer to the Mosart Web Apps 
Release Notes for your version of Viz Mosart, at the Vizrt Documentation Center. 
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7.1 Working with the Rundown Viewer
 Opening the Rundown Viewer
 Key features

 Viz Mosart Server status
 Story Scaler
 Story Script
 Go to On Air Story

The Mosart Rundown Viewer provides a convenient, browser based display of a Viz Mosart rundown.

7.1.1 Opening the Rundown Viewer
You launch the Mosart Rundown Viewer from the Mosart Web Applications Configuration Tool.

1. From the Mosart Web Apps Configuration Tool, select App Launcher > Rundown Viewer:

2. The Mosart Rundown Viewer displays in your default web browser.

Note: To browse a rundown in Rundown Viewer, a standard Viz Mosart setup must first be running with a 
loaded rundown.

Copyright © 2025  Vizrt                                                          Page  71



Viz Mosart Web Applications -  2.5

7.1.2 Key features

Viz Mosart Server status
Viz Mosart server status will be displayed in the upper right corner:

Status Description

Viz Mosart server is active

Viz Mosart server is idle

Manus Admin is not running or Mosart Remote Control Service (RCS) is 
not running or it is not accessible.
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Status Description

Viz Mosart is setup with main and backup and backup Mosart server 
has been configured in Viz Mosart Web Config Tool > Server 
Configuration.

By default, the hostname, IP address, or FQDN configured in the Viz Mosart Web Config Tool > Server Configuration
for the main and backup Viz Mosart servers will be displayed. However, in newer versions of Viz Mosart, the Server 
Description configured on each Viz Mosart Server under Manus Admin Settings is used instead.

Story Scaler
You can expand the viewing area for items in a story row. This is useful to see full text details on an item.

 Adjust the story scaling to desired column width.
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Story Script
You can work with the story script from within the Rundown Viewer.

Go to On Air Story
A navigation button

enables immediate scrolling to the current on-air story.
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Tip: For an explanation of the elements in a Viz Mosart rundown, please refer to the Viz Mosart User Guide, 
under User Interface, the section Rundown Window. 
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7.2 Setup and Administration of RV
 Setting up the Rundown Viewer

 Prerequisites
 Installation and Configuration

 Optional Server Setups
 Support for Main/Backup Connection
 Support for HTTPS

 Troubleshooting

7.2.1 Setting up the Rundown Viewer

Prerequisites

 Viz Mosart 5.1.0 or later

Installation and Configuration
The Rundown Viewer requires no additional configuration.

1. Ensure that your Viz Mosart system is operating under normal working conditions.
As a minimum,

a. Manus Admin must be running.
b. The Viz Mosart UI is running, displaying a rundown.

2. From the Mosart Web Apps Configuration Tool, select App Launcher > Rundown Viewer.
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7.2.2 Optional Server Setups

Support for Main/Backup Connection

 If you have a backup server for redundancy, you will need define the environment in the menu section Server 
Configuration.

Support for HTTPS

 If you are using HTTPS, you will need define the environment in the menu Server Configuration.

7.2.3 Troubleshooting
Please refer to section Troubleshooting.
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8 Showmaker
Showmaker is a lightweight, efficient MOS rundown creation tool that does not require a newsroom system.

This version provides all features needed to quickly create and control a Viz Mosart show.

8.1 Typical Usage
 Produce shows without the need of a newsroom system.
 Produce Viz Mosart-automated shows, without the existing newsroom system providing the rundown.
 Provide an independent backup for the newsroom system.

 Ability to get on air quickly.
 The beginning of a project.
 The automation is prepared in advance, not requiring any newsroom system.
 When a newsroom system is in use, all automation can first be prepared in Showmaker, in advance of 

the newsroom system.
 Where skeleton staff (for example, in the middle of the night) need to get breaking news on-air.

8.2 Additional Features
 Works with Viz Flowics (HTML graphics) and Viz Pilot Edge graphics plugins.
 Modern, web-based architecture.
 Support for MOS 4.

8.3 Further Information
If you require assistance with setting up Showmaker, please reach out to your Viz Mosart Support contact.
Additional documentation will appear in the next release of the Vizrt Web Apps package.

Info: Showmaker is not intended as a replacement for a newsroom system. Showmaker offers a self 
contained, quick and easy way of building a rundown.
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8.4 Working with Showmaker
This is a pre-release of Showmaker.

 Showmaker can run standalone, as a rundown (running order) creation tool.
 If you wish to use Showmaker with Viz Mosart, follow the instructions in section App Configuration.

 Making your Rundown
 Newsroom Tags for Pre-production Accuracy

8.4.1 Operational Examples
This pre-release version of Showmaker is evolving rapidly. Already many tasks and workflows are fully functional.
Below is a starting point for finding some useful descriptions online:

Making your Rundown

 This short introductory video takes you through the basics, so you can get started.

Newsroom Tags for Pre-production Accuracy

 This 3-minute clip uses Mosart web Apps to link smart Viz Mosart operations to the show’s rundown.

8.4.2 Documentation Updates
As development evolves, the documentation is updated. Between software updates, it will be made available at the 
Vizrt Documentation Center.

Note: Whilst setup is relatively simple, the precise configuration depends on whether Showmaker is 
installed on the same server as Viz Mosart or a networked machine.
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8.5 Setup and Administration of Showmaker
This is a pre-release of Showmaker.

 Please follow the standard setup described in section Mosart Web Apps Configuration Tool.

 Setting up Showmaker
 Prerequisites
 Installation and Configuration

 Optional Server Setups
 Support for Main/Backup Connection
 Support for HTTPS

 Troubleshooting

8.5.1 Setting up Showmaker

Prerequisites

 Viz Mosart 5.1.0 or later

Installation and Configuration
You can create a standalone, pre-production rundown in Showmaker with no additional configuration.

However, to work with Viz Mosart templates or to test the rundown, you must perform these one-off configuration 
steps:

To manage Mosart templates
To work with Viz Mosart template sets in Showmaker, the bundled web application NRCS Plugin shall be correctly 
configured.

 Follow the Showmaker instructions under section App Configuration.

To connect to Viz Mosart
To verify your Showmaker rundown in Viz Mosart, you will need to configure your browser’s connection to the 
Mosart server.

1. Ensure that your Viz Mosart system is operating under normal working conditions.
As a minimum,

a. Manus Administrator must be running.
b. The Viz Mosart UI is running, displaying a rundown.

2. From the Mosart Web Apps Configuration Tool, select App Configuration and complete the required setup.

Info: Documentation is continually updated, see the latest version at the Vizrt Documentation Center.
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3. With these steps completed, Showmaker is ready to work with Viz Mosart.
You may need to consider the scenarios presented in Optional Server Setups below.

8.5.2 Optional Server Setups

Support for Main/Backup Connection

 If you have a backup server for redundancy, you will need define the environment in the menu section Server 
Configuration.

Support for HTTPS

 If you are using HTTPS, you will need define the environment in the menu Server Configuration.

8.5.3 Troubleshooting
Please refer to section Troubleshooting.

Copyright © 2025  Vizrt                                                          Page  81



Viz Mosart Web Applications -  2.5

9 Template Editor
The new Template Editor offers an improved experience for creating, editing and managing templates.

This guide is designed for both first-time users of Viz Mosart and experienced users of the old Template Editor, 
providing detailed explanations of the features, workflows, and recommended best practices.

 Template Editor
 Benefits of the new Template Editor
 How the new Template Editor Works
 Further Information

9.1 Template Editor
The Template Editor is your tool for creating, modifying, and managing templates. Each template defines a 
carefully timed sequence of automated commands, such as camera switching, audio adjustments, graphic 
transitions, lighting control and much more. By designing robust and powerful templates, you can produce 
complex live broadcasts reliably and consistently, which can be planned in a rundown, or recalled manually at any 
time.

Tip: Watch a 2' introduction here.

Info: Early Access
The new Template Editor is currently provided as an early access version, intended for customers to test, 
explore, and provide insights and feedback for future versions.

Safety first
This version is not supported for production use. We recommend enabling it in a staging or test 
environment to safely explore its features and to always back-up your channeltemplates.xml file before 
you start. 

Template storage
Once enabled, the new Template Editor will share the same template storage configuration as the NRCS 
plugin.
Only file-based template storage is supported in this version. Support for template database will follow in 
a later version.

Control access
As a web-based app, the new Template Editor will be available to all users on the local network. To control 
access, this version also offers authentication.
Once configured, the permissions apply to all Viz Mosart Web Apps. 
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9.2 Benefits of the new Template Editor
 Web-based: Accessible from a browser on any computer on the network.
 Fast template browsing: Uses the same familiar interface as the NRCS Plugin, for rapid navigation between 

templates.
 Timeline view: Gives a clear visual overview of all commands and their precise timing.
 Simplified command model: Fewer, more powerful commands, to make template creation easier.
 Easier to learn: A clean, intuitive UI lowers the learning curve, even for new users.

9.3 How the new Template Editor Works
The new editor is designed to be compatible with existing Mosart templates, while introducing a more modern and 
user-friendly editing experience. Here's what you need to know:

 Template Editor directly modifies the same channeltemplates.xml  file as the old editor.
 The data format is the same, so changes are backwards compatible. Both editors can be used side-by-side.

  However, there is no mechanisms for synchronizing between them:
 Saving in the old editor: Requires a browser refresh in new editor to view the changes.
 Saving in the new editor: Requires a restart of AV Automation for changes to take effect in a 

rundown and to see the changes in the old editor.
 There are no conflict or collaboration features: The latest save wins.

 This version supports a limited set of commands:
 When opening an existing template, only the supported commands will be visible.
 When saving, unsupported commands are preserved, even though you don’t see them. They are not 

lost.
 All commands will still appear in the old editor.

 Commands have been simplified, but may take some time to get used to:
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 The previous distinction between Device Commands and Control Commands is gone. Now you see a 
unified list.

 Some commands have been unified for simplicity. For example, the command Set source can set a
Keyer, AUX or Crosspoint, depending on which properties have been configured.

 This change is only visual. When saving, a Set source, the command will be converted to a 
SET_CROSSPOINT Control Command in the file and is visible in the old editor.

 For more details, see Transitioning from the old Template Editor.
 No template inheritance features are currently included.

9.4 Further Information
Additional documentation and guidance will continue to be added and refined as the new Template Editor evolves. 
For the latest updates, consult the Vizrt Documentation Center. If you require assistance with setting up Template 
Editor, please reach out to your Viz Mosart Support contact.

Copyright © 2025  Vizrt                                                          Page  84

https://docs.vizrt.com/mosart-webapps.html


Viz Mosart Web Applications -  2.5

9.5 Working with Template Editor
The opening view of the Template Editor provides access to all tools needed to browse, edit, and manage Mosart 
templates. Key operations like template selection, command editing, and property configuration are gathered in 
one workspace.

Each panel serves a specific phase of your template editing workflow. For example:
- searching and managing templates
- editing commands
- configuring properties.

The layout is intended to offer a visual and intuitive experience, with tools like timeline visualization, structured 
command organization and real-time property editing.

9.5.1 Overview of Template Editor
Each numbered panel is described below.

 (1) Template Search and Creation
 (2) Template Title Bar
 (3) Commands List and Timeline View
 (4) Audio Fader Panel
 (5) Command Properties
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(1) Template Search and Creation

Searching for Templates
The Template Editor provides a fast and responsive search experience similar to what you may be familiar with in 
the Mosart NRCS Plugin.

 Select a Template set from the drop-down selector, to view its templates.

 Use FILTER BY SET NAME to locate a template set.
 Having selected a template set, type in the Search box to locate templates by name or variant.

As you type, the list will automatically filter and highlight matching results.
 Templates are grouped by type, such as CAMERA, PACKAGE, or GRAPHIC, making browsing straightforward 

even without searching.
 When you select a template from the list, its implementation is instantly loaded and displayed in the 

Commands and Command properties panels on the right. This allows you to preview its configured 
commands, transitions, and audio fader levels at a glance—without needing to open each one manually.

 Use the Arrow keys on your keyboard to quickly scroll through the templates within your selected set. As 
you move through them, each template’s configuration is shown instantly, offering a fast and efficient way 
to review templates in sequence.

Copyright © 2025  Vizrt                                                          Page  86



Viz Mosart Web Applications -  2.5

Creating a New Template

To create a new template
1. Click the + Create new button at the top of the template list.
2. In the dialog:

 Title – Enter a name for your new template.
 Type – Choose a template type from the drop-down menu (for example, CAMERA, PACKAGE).
 Description (optional) – Optionally, provide a short description for clarity.

When creating a new template, the combination of template Type and variant name (Title) must be 
unique within the selected template set.

Info: In this version, only file-based templates are supported. This means you won’t need to select a 
gallery, as only one template source (the file) is available. Support for gallery-based template databases 
will be introduced in a future release.
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3. Click Create to add the new template.
It is added to the selected set and immediately opened in the main editor view.

4. Once created, you can begin adding commands, adjusting their properties, and configuring timing in the 
visual timeline editor.

Collapsing the Search panel
Once you’ve found a template to view or edit, or created a new one, you can collapse the Templates panel using 
the Collapse icon in its top-right corner.
(You may need to move your mouse to hide the panel).

Collapsing the panel provides more workspace and visibility for editing the template body and viewing command 
details. This is especially useful when working with complex templates or multiple commands, as it allows you to 
focus on the command timeline and property panels without distraction.
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You can re-expand the Templates panel at any time by clicking the menu icon in the top-left corner, allowing you to 
browse template sets or search for additional templates without leaving the current view.

(2) Template Title Bar
The header section of Template Editor displays key information and actions related to the currently selected 
template. This panel provides access to template metadata, delay configuration, and management tools.

What you’ll find in this section:
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 Template Information
Displays the selected template's name, variant, description and location. This makes it easy to keep track of 
what you're editing, especially when navigating across multiple templates.

 Mix Delay Configuration
Clicking Set Mix Delay opens a dialog where you can apply a frame-based delay to specific command types 
(for example, main source switches, region source switches, audio fades). This helps with fine-tuning on-air 
action timings.
If Mix Delay is enabled, individual command offsets will be ignored.

 Template Actions – Save, Edit, Delete
On the right side of the header:

 The Save button stores any changes made to the template.
 The Three-dot menu opens options to Edit or Delete the template.

 Edit opens a dialog where you can rename the template, change its type, update its 
description, or modify its Mix Delay value.

 Keyboard Shortcuts and About
The Question mark icon (?) opens a drop-down menu with:

 Documentation
 Keyboard Shortcuts – view or memorize shortcuts to speed up common actions like creating, 

editing, and navigating templates.
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 About Dialog – includes product version, date, and a link to third-party license information used by 
the Template Editor.

(3) Commands List and Timeline View
The Commands panel presents two complementary methods for exploring and managing commands in a 
template.

 Select Timeline or List view to switch between views.

Both views are interactive and synced with the Command properties panel.

Timeline View
A visual representation that shows when each command is executed during the Cue, Take, or Out phases. It 
provides an intuitive overview of execution timing, offset frames, and transition lengths.
In addition, this view helps illustrate multi-phase commands, such as Switch Main or Switch Region—that trigger 
actions when the template is cued and when it is taken on-air. These distinct phases are easily identified on the 
timeline by their placement across Cue, Take, or Out segments.

List View
A compact format that displays the same commands and their core properties in a simplified linear layout.
This is useful for quick review or editing when precise timing visualization is not required.

Info: Commands are currently grouped by device category (for example, switcher commands, audio mixer 
commands) and not by execution sequence.
This reflects the structural grouping within a template, but not necessarily the order that Viz Mosart 
executes them at runtime.
Additional sorting options may be introduced in future versions.
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Adding Commands to a Template

To add a new command
1. Click the Plus button (+) located at the top-right corner of the Commands view.
2. This opens a dialog that lets you browse available device types (for example, Switcher, Audio Mixer) and 

choose specific commands to insert into the template.
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3. Each command entry in the dialog provides a short description.
Click Show more for additional information.

4. Select the desired command and click Add to include it in the active template.
5. You can continue editing the newly added command in the Command properties panel, immediately after 

adding it.

(4) Audio Fader Panel
The Audio Fader panel provides a quick overview of all Set Fader commands included in the template.
Displayed for each configured audio channel are:

 The source name (for example, MIC 1, MIC 2)
 The fader level, in dB.
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You can adjust the audio level directly by dragging the fader slider up or down. This allows quick tuning without 
navigating to the Command properties panel.

 To modify other command parameters like Trigger type, select the corresponding audio command from the 
Command list or Timeline view.

(5) Command Properties
The Command Properties panel displays configurable options for the selected command. Properties vary 
depending on the command type and device type (for example, a video switcher or an audio mixer).
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9.6 Setup and Administration of TE
The new Template Editor is part of the Mosart Web Apps package. It is accessed and managed through the 
Configuration Tool, which launches automatically after installation.

1. Open the Configuration Tool.
After installing the Web Apps bundle, the App Launcher will open, showing all available applications. 
Template Editor is listed as one of the applications but must be enabled to become accessible.

2. Enable Template Editor.
a. Go to the App Configuration tab.
b. Select Template Editor.
c. Review the following important notes before enabling.
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3. Save and launch.
Once you've enabled the Template Editor:

a. Click Save to apply the change.
This restarts the Web Apps service.

b. After restarting, the Open button becomes available.
Click Open to launch Template Editor in your default browser.

4. Confirm template storage file location.
Template Editor shares the template storage path configured in the NRCS Plugin tab.

 Ensure the Local file storage path is valid and accessible.

Info: Templates stored on a database are not supported in this version.
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5. Control access.
As a web-based app, the new Template Editor will be available to all users on the local network.

 To control access, this version also offers authentication. Once configured, the permissions affect all
Viz Mosart Web Apps.
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9.7 Command Reference
This section explains the supported command types in the new Template Editor.

It covers their function, parameter structure, and how they are used in real-world workflows.

 Command Types
 Video Switcher Commands
 Audio Mixer Commands
 Fine-tuning On-Air Action Timings
 Template Terms and Definitions

9.7.1 Command Types
Commands in this description are organized by the type of device they control (for example a switcher or audio 
mixer) with examples illustrating their common usage scenarios.

For users familiar with the existing desktop Template Editor, a separate section, Transitioning from a Desktop 
Template Editor, highlights key differences in behavior and compatibility.

As the Template Editor evolves, more command types will be added.

9.7.2 Video Switcher Commands

Command Structure
For video switcher (vision mixer) commands that assign a source, such as Switch Main, Switch Region, or Set 
Source, the web-based Template Editor uses a structured mapping system to precisely define where the source 
should appear. This structure is:

Region → Layer → Channel → Source

This hierarchical model supports a wide range of production systems, from traditional hardware switchers to 
modern software-based mixers. While it is essential for source-mapping commands, not all vision mixer commands 
necessarily use this structure.

Here’s a breakdown of each element:

Region
The top-level destination for the source. This could be:

 Program/Preview (PP): the main switcher output
 Mix/Effect (ME1, ME2, etc.): for complex layer compositions
 Auxiliary (AUX): for independent outputs

In some systems, this is called a scene (Panasonic Kairos), or a graphic scene (see Viz Engine as a 
Switcher).
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Layer
Identifies a compositing layer (for example, Background, Layer 1, Layer 2, Layer 3) where the source should be 
placed.

 The Background (also referred to as Main) layer represents the base layer of the visual composition, the 
foundation onto which all other visual elements (graphics, overlays, picture-in-picture, etc.) are added.
This layer may support A/B transitions (Preview + Program). In traditional switchers, this corresponds to the 
background video source of any M/E bank, not just the Program output.
Each M/E has a base input (the Background), which can have keys and effects stacked above it. In modern, 
layer-based switchers like Panasonic Kairos, it serves as a virtual construct to simulate this foundation. The 
web-based Template Editor uses this concept to unify how the base layer is addressed across both 
traditional and fully composited switcher architectures.
Note: This layer is not available when region Auxiliary is selected.

 Layer 1, Layer 2, Layer 3, and so on, are used to place content on top of the main background layer. Each of 
these layers currently has just one video bus (called A) and currently does not support transitions between 
two sources like traditional A/B transitions.
Examples are:

 Panasonic Kairos supports multiple layers in both single and dual-bus modes.
 TriCaster M/Es allow multi-row compositions (A, B, C, D).
 Viz Engine treats superchannels as layers with A/B buses.

The Layer may be fixed based on command type (for example, Switch Main does not expose a layer setting, 
this is set by default to Background and cannot be changed).

Channel
This is the final destination where the source is assigned. In a dual‐bus background layer, this might be A (program) 
or B (preview). Single-bus layers typically only use channel A.

Source
The actual input, such as a camera, live feed, graphics input etc., referenced by its name (crosspoint) configured on 
the Viz Mosart server in AV Automation in the menu
Devices > A/V Setup > Video Config. (for example, CAM1, LIVE1).

Switch Main
The Switch Main command sets the source on the main output (Program/Preview) of the switcher. This can be a 
direct source like a camera, graphic, or video feed (for example, CAM1), or a secondary region (for example, ME1) 
that is being composed elsewhere.

Properties
 Region: Program/Preview (the main output). This can not be changed.
 Source: The desired source (e.g., CAM1). Default: the first command in the list.
 Trigger: Specifies where the command is executed. This can not be changed. The command transitions the 

selected source on the main output from Preview (B) to Program (A) when the template is taken on air. In the 

Copyright © 2025  Vizrt                                                          Page  99

https://docs.vizrt.com/viz-mosart-admin-guide/5.11/Panasonic_Kairos_Vision_Mixer.html
https://docs.vizrt.com/viz-mosart-admin-guide/5.11/TriCaster_and_Viz_Mosart.html
https://docs.vizrt.com/viz-mosart-admin-guide/5.11/Viz_Engine_as_a_Switcher.html
https://docs.vizrt.com/viz-mosart-admin-guide/5.11/Audio_and_Video_Setup.html#id-(5.11)AudioandVideoSetup-VideoConfigurations


Viz Mosart Web Applications -  2.5

Properties on the command on TAKE is visualized, but in the Timeline view, both the commands on CUE and 
on TAKE are visualized.

 Offset: Optional delay in frames. Ignored when Mix Delay is enabled; instead, the Mix Delay applies a unified 
offset to this and other commands. Default: 0 frames.

 Transition: CUT, MIX WIPE or EFFECT. CUT is in fact a MIX with transition rate 0 frames. Default: CUT
 Transition rate: MIX and WIPE support optional transition rate (in frames). Default: 0 frames.
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Switch Region
Switches a source to the background of another mixer region (for example, ME1, ME2) different from the main 
output (PP). This allows for switching sources in parallel with the main output - typically used in compositions, 
picture-in-picture, or secondary outputs.

Command properties
 Region: ME1, ME2, etc.
 Layer: 1, 2, 3 etc.
 Source: The desired source (for example, CAM1). Default: The first command in the list.
 Trigger: Specifies where the command is executed. This cannot be changed. The command transitions the 

selected source on the mixer region from Preview (B) to Program (A) when the template is taken on air.
In the command Properties view only the TAKE command is shown, but in the Timeline view, both the 
commands on CUE and on TAKE are visualized.

 Offset: Optional delay in frames. Ignored when Mix Delay is enabled; instead, the Mix Delay applies a unified 
offset to this and other commands. Default: 0 frames.

 Transition: CUT, MIX WIPE or EFFECT. CUT is in fact a MIX with transition rate 0 frames. Default: CUT.
 Transition rate: MIX and WIPE support optional transition rate (in frames). Default: 0 frames.

Set Source
The Set Source command is used to assign a specific source to a single-bus layer, typically used for keyers, picture-
in-picture, video walls, auxiliaries or other compositional elements within a production scene.

Unlike Switch Main or Switch Region, which operate on background layers and typically trigger a transition (for 
example, Mix, Cut), Set Source is used for direct source assignments that do not involve transitions.

Command properties
 Region: Specifies the mixer region where the source should be applied. For example, Program/Preview (PP), 

ME1, ME2, Auxiliary, etc.
 Layer: Indicates the layer within the selected region. Can be Background (except when Region is set to 

Auxiliary) or a numbered layer (for example, Layer 1, Layer 2, etc.).
 Channel: Defines the channel to assign the source to, A or B. This is only applicable when the Layer is set to 

Background.
 Source: The source to be assigned (for example, CAM1, LIVE1). If left empty, the first available source in the 

drop-down list is used by default.

Info: Limitations with current version
 A maximum of two switch commands are supported in a single template execution

 one for PP (main) and
 one for a secondary region (for example, ME1).

 Only one non-main region (ME1, ME2, etc.) can be used for Switch Region.
 Shared transition and offset: Both Switch Main and Switch Region commands in a template will 

use the same transition type and same offset.
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 Trigger: Specifies when the command should be executed, on CUE, TAKE, or OUT.
 Offset: An optional delay (in frames) before the command is executed. In this version, the Offset property 

can only be applied if the Trigger is set to CUE.

Examples
 Assigning keyers for a 2Box composition.

This template uses two Set Source commands to assign video sources to different keyer layers on the ME1 
region.

 The first command maps CAM1 to Layer 1, used as the left video box.
 The second command maps LIVE2 to Layer 2, used as the right video box.

This setup is commonly used in 2Box or split screen layouts, where two speakers or feeds need to be 
shown side by side, with the ME handling the composition.

 Taking multiple sources simultaneously
This template prepares and takes multiple sources simultaneously: It sets LIVE1 to preview (channel B) of 
ME2 on cue, then switches LIVE1 to program (channel A) of ME2 and routes Aux1 to an auxiliary layer when 
the template is taken.

Info: The Mix Delay setting (defined at the template level) applies to the Set Source command only if:
 the Layer is set to Background, and
 the Trigger is set to TAKE.
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9.7.3 Audio Mixer Commands

Set Fader
The Set Fader command is used to adjust the audio level of a specific source at a defined point in the template 
timeline.

Command properties
 Source: The audio input to be controlled (e.g., Mic1, Mic2, etc.) as configured on the Viz Mosart server in AV 

Automation in the menu
Devices > A/V Setup > Audio Config.

 Level: The target audio level in decibels (dB). Typical range is from 0 dB (max) down to -90 dB (silent).
 Trigger: Defines when the fader level should be applied: on CUE or TAKE.

Info: The Mix Delay setting (defined at the template level) applies to the Set Fader command only if the 
command is executed on TAKE.
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9.7.4 Fine-tuning On-Air Action Timings
In the Template Editor, you can control when certain actions are executed relative to the moment a template is 
taken on-air. This is done using either:

 A global Mix Delay, defined in the template properties.
 An individual Offset, defined per command.

Some commands support both, depending on their configuration.

Mix Delay introduces a shared delay (in frames) applied to eligible commands when the template is taken on-air. 
It's useful when you want multiple commands delayed together, in a coordinated way.
In addition to a template’s Mix Delay, some commands also support their own Offset property, an individual delay 
in frames.

Delay mechanism summary

Command Type Mix Delay applies if Offset applies if

Switch Main Trigger is TAKE Mix Delay is not set

Switch Region Trigger is TAKE Mix Delay is not set

Set Source Layer is Background and Trigger is TAKE Trigger is CUE
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Command Type Mix Delay applies if Offset applies if

Set Fader Trigger is TAKE Not supported

9.7.5 Template Terms and Definitions
Some common terminology used in template and show design:

 Directtakes: A special template set, where templates in this set are intended to be manually executed in an 
ad-hoc fashion.

 Empty template: An undefined, non-operative template. An empty template does nothing when executed. 
Note that empty templates are not displayed in the Viz Mosart client.

 Gallery: Corresponds to a Viz Mosart installation. Typically a gallery has a dedicated Viz Mosart server, with 
configured utilities and a Viz Mosart client.

 Show design: The background task of creating a set of templates, in a logical and programmatically valid 
order, for controlling a scheduled, rundown-driven, studio transmission.

 Template description: The template properties common for all Viz Mosart installations in a shared 
template set. This description uniquely identifies and describes the template.

 Template implementation: Contains the behavior or device control aspects of the template. The template 
implementation is related to the Viz Mosart installation.

 Template set: Viz Mosart templates are always contained in a template set. There may exist 
multiple versions of the same template but in different template sets.
A template is uniquely defined by its type and variant name within its corresponding template set.

 Template type: Template type or category. Viz Mosart has a predefined set of template types. Each are 
displayed with a distinct visual appearance. 
Examples of template types are CAMERA, PACKAGE, VOICEOVER, LIVE, GRAPHIC and DVE.

 Template variant: Unique identifier of a template for given template type within a template set.
For example, camera1 and camera2 are two variants of a Camera template.
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9.8 Transitioning from the old Template Editor
Here we review considerations when adopting the new Template Editor.

 Mapping Desktop Template Editor Commands to the Web Apps Template Editor
 Currently Unsupported Command Properties
 Examples
 Legacy commands

9.8.1 Mapping Desktop Template Editor Commands to the Web Apps Template 
Editor

Desktop TE Web Apps TE Notes

Switcher crosspoint Switch Main
Switch Region

Switching sources is 
supported for a 
maximum of two regions 
in parallel, one of which 
must be the main output 
(PP).
See Currently 
Unsupported Properties.

KeyFill Set Source Layer=1, 2, 3 etc. Trigger=TAKE See Currently 
Unsupported Properties.

Auxiliary Set Source Region=Auxiliary Layer=1,2,3 etc. 
Trigger=TAKE

See Currently 
Unsupported Properties.

SET_CROSSPOINT Set Source Layer=1, 2, 3 etc. Trigger=CUE/OUT

Set Source Region=Auxiliary Layer=1,2,3 etc. 
Trigger=CUE/OUT

Set Source Layer=Background Channel=A/B 
Trigger=CUE/TAKE/OUT

See Currently 
Unsupported Properties.

Copyright © 2025  Vizrt                                                          Page  106



Viz Mosart Web Applications -  2.5

Desktop TE Web Apps TE Notes

SET_AUXILIARY_CR
OSSPOINT

Set Source Region=Auxiliary Layer=1,2,3 etc. 
Trigger=TAKE

This control command is 
visible in the desktop 
Template Editor but it is 
not executed by Viz 
Mosart.
This command cannot be 
recreated in the web-
based Template Editor, 
but a Set Source
command can be used to 
assign a source on an 
auxiliary.

See Currently 
Unsupported Properties.

Set Source Region=Auxiliary Layer=1,2,3 etc. 
Trigger=CUE/OUT

Not supported in this 
version.

Audio Fader Set Fader See Currently 
Unsupported Properties.

9.8.2 Currently Unsupported Command Properties
This section lists command properties that are currently not supported in the new web-based Template Editor. 
These properties apply to commands already available in the editor but are either not implemented yet, planned 
for future support, or will be deprecated or handled differently in upcoming versions.

Switcher Crosspoint

 Audio link
 Cross Point Hold
 Down stream keyer
 Mix Delay Out
 The combination Mix Delay set to 0 frames and Transition Only checked. This executes the video transition 

with no delay after all the commands have been executed.
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KeyFill

 Audio link
 Key Enable

Auxiliaries

 Audio link
 Trans Dur
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Faders
Most of the fader properties are not yet supported in this version:

 Order
 Fader type
 Fader Action
 Link
 Keep level
 Input device
 Cross fade time
 Manual close
 Mode
 Delay
 Loudness
 Set level 2
 Set level 3
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Control Commands
Only SET_CROSSPOINT commands are currently supported in the Web Apps Template Editor with some exceptions:

 SET_CROSSPOINT as a continue point:
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9.8.3 Examples
Here are some examples of templates created in the desktop Template Editor and how they are represented in the 
new Template Editor.

1. Switch different sources on the main output (PP) and another mixer region (ME1) with a mix rate > 0.

Info:
 SET_CROSSPOINT with Value=AUX can be configured in the desktop Template Editor, but it is not 

actually executed by Viz Mosart.
 SET_AUX_CROSSPOINT, although available in the desktop Template Editor, is not executed by Viz 

Mosart.
 SET_CROSSPOINT on TAKE OUT cannot be properly configured in the desktop Template Editor. 

This is however, supported in the new web-based version.
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2. Switch M/E into the main output (PP) with a WIPE and rate > 0.
Note: The same commands could be executed in the web-based if Crosspoint PP is set to ME1 instead of 
using Set ME in PP property in the desktop Template Editor.

3. Switch a Mix/Effect (M/E) source into the main output using an effect transition, while also applying a mix 
delay across multiple commands.
In addition, an audio fader adjustment is performed as part of the same template.

Copyright © 2025  Vizrt                                                          Page  112



Viz Mosart Web Applications -  2.5

4. Take a DVE composition with multiple video and audio elements.
In this template, two video sources (LIVE1 and CAM4) are inserted into a DVE layout (via ME1), which is then 
switched into the main output using a mix transition with a custom rate. Simultaneously, two audio faders 
(LIVE1 and MIC1) are adjusted. A mix delay is applied across multiple commands to synchronize the 
execution.

5. Assign a source to ME3 bus B at cue, and transition the same source to bus A on take:
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6. Set fader level when the template is cued and when it is taken. A Mix Delay set on the Switcher crosspoint will 
apply to the audio fader, to be executed on take.

9.8.4 Legacy commands

Control Commands to set the Source on a Mixer Region Keyer
In the desktop Template Editor, you could add a control command on take like this:
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SET_CROSSPOINT on take ME1 "1:CAM1"
This instructs Mosart to switch ME1 to input CAM1, using the bus number 1 to specify the source.

When this type of command is imported into the web-based Template Editor, it is recognized as a legacy command
and preserved in its original form. If a Mix Delay is set on the template, this applies to all the control commands on 
take. This is visualized in the web-based Template Editor as in the screenshot below:

However, if you recreate a command in the web-based editor with the same Region and Source settings, the 
command will be exported to the desktop Template Editor as a KeyFill command. Mix Delay will not apply to this 
command. Instead, you can use the Offset property to delay the command execution relative to the Take.
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Control Commands to set the Source on an Auxiliary
Control commands to set the source on an auxiliary are also considered legacy commands and can not be recreated 
using the web-based Template Editor.

If a Mix Delay is set on the template, this applies to all the control commands on take.
This is visualized in the web-based Template Editor as in the screenshot below:

If a command with exact properties is added in the web-based editor, it is translated into an Auxiliary command in 
the desktop version. Mix Delay will not apply to this command. Instead, you can use the Offset property to delay 
the command execution relative to the Take.
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10 Stream Deck
The Elgato Stream Deck plugin for Viz Mosart allows you to send Viz Mosart rundown actions including Start/
Continue, Skip Next, Unskip Next, Take a template. You can also fire a Direct take or a Control command.

The plugin communicates directly with the Mosart server and all actions are triggered without needing a Mosart GUI 
open, active or in focus.

 Installation
 Configuration
 Actions
 Status
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10.1 Installation

10.1.1 Software Download

To download Stream Deck for Windows
1. From Elgato's site, https://www.elgato.com/us/en/s/downloads

select Stream Deck for Windows software and download.
The Stream Deck utility starts up automatically after install.

2. If not already installed, download and install the latest version of Viz Mosart Web Apps, located on the Vizrt 
FTP at
/products/VizMosart/Latest Version/WebApplications/
and perform the one-time Server Configuration setup.

3. From the Web Apps installation folder, locate the plugin file com.vizrt.mosart-remote.streamDeckPlugin.
4. Double click the file com.vizrt.mosart-remote.streamDeckPlugin for installation on the same PC where you 

just installed the Stream Deck for Windows software.
5. Accept when the Stream Deck application requests installation confirmation.
6. After installation, the Viz Mosart section displays with newly available actions.

Note: The software can be installed on a different machine than the Viz Mosart Server or Mosart GUI client.

Note: The Server Configuration is essential if you have a main/backup setup. For a simple, single server, 
you can skip the Server Configuration step.
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10.2 Configuration

10.2.1 Configuring the Mosart Host

To configure the Viz Mosart host
1. Drag the Start/Continue rundown to any free Stream Deck key.
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2. Click Open Global Settings to configure the plugin.

3. In field Mosart Url, enter the URL of either
a. The IP address or hostname of your main or backup Mosart server (Failover is not supported).

This REST API endpoint IP address or hostname must be prefixed with http:// (or https if used) and 
suffixed with port number :55167. See the screenshot for an example.
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b. The hostname of where your Mosart Web Applications are installed (Here, failover is supported).
This Mosart Web applications proxy web server must be prefixed with http:// (or https if used) and 
suffixed with port number :55142. See the screenshot for an example.

5. In field X-API-key enter the key.

6. Click Save & Close. (The settings are set once-only and are saved for all operations).

10.3 Actions
 Start/Continue Rundown
 Reload rundown
 Restart from top
 Fire direct take
 Take Template
 Rehearsal Mode
 Skip Next
 Unskip Next
 Control Command

10.3.1 Start/Continue Rundown
This action lets you Start or Continue the rundown. (The equivalent of a GUI timeline key Start Continue).

Options

 Default: The next templates default transition.
 Mix or Wipe: Presents the rate entry field.
 Effect: Enter the effect number.

10.3.2 Reload rundown
This action will trigger a rundown reload event. I.e. the timeline will be stopped and the current rundown will be 
reloaded from the NRCS. No additional parameters.

10.3.3 Restart from top
Restart the rundown from the first story. No additional parameters.

Note: See the Viz Mosart Web Applications Config Tool User Guide (section Server Configuration) for more 
information about the Mosart Web applications proxy web server.

Note: See the Appendix topic Mosart Remote Control REST API in the Viz Mosart Administrator Guide for 
more information about REST API endpoint and X-API-key.
For redundancy setup, configure the same API-key on both main and backup.
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10.3.4 Fire direct take
Trigger a given DirectTake template. You must provide the number of the desired template. Option to show or hide 
the direct take icon.

10.3.5 Take Template
This action takes a template by its type and variant (name) and which bus.

 Template Type - choose the template type first to be used, eg: Camera, Package ect.
 Variant - enter the exact variant name from your channel templates belonging to the chosen template type.
 Program/Preview - Select the preferred way to insert this template into the current running story
 Show Icon - option to show the template type icon on the stream deck device button.

10.3.6 Rehearsal Mode
This action will either enable/disable/toggle rehearsal mode depending on selection of Rehearsal Mode.

The Rehearsal mode icon on the stream deck device will display yellow when rehearsal mode is activated either 
from this action or from the GUI.

10.3.7 Skip Next
This action will skip the next item or sub item in the rundown.
Choose Skip Type in the drop down menu.

10.3.8 Unskip Next
This action will unskip (undo) the a skipped item or sub item in the rundown.
Choose Skip Type in the drop down menu.

10.3.9 Control Command
This action will execute a control command on Viz Mosart.

Choose the control command to execute from the drop down menu. You can add parameters in the text area in the 
form “Param1=val1”, separated by new line.

10.4 Status
The status of the current connected server is displayed.

 GREEN status - Connected

Tip: A full list of the supported control commands and their parameters refer to the Viz Mosart 
Administrator Guide, in the Appendix section Mosart Remote Control REST API.
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 YELLOW status - Standby/Idle

 RED status - Not connected

Pressing this key on the Stream Deck device performs no action.

Note: When installing the Mosart Plugin, you may need to close and reopen the Stream Deck client 
application, to enable displaying of status.
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11 Troubleshooting
 Web Apps Configuration Tool

 The Mosart Web Proxy Service is not running or is not functioning properly
 The Mosart Web Applications Service is not running or is not functioning properly
 The External Proxy Service is unreachable or not functioning properly
 Unable to reach the Viz Mosart Server (main or backup)
 The Web Applications Service is not running

 Rundown Viewer and Timing Display Issues
 Issues with Mosart Web Server Connecting to the Mosart Server

 Mosart Remote Control Service (RCS)
 Firewall Ports

 Browser Logs

11.1 Web Apps Configuration Tool
The Mosart Web Applications Configuration Tool provides you with error or warning messages that assist with 
common issues.
These messages may include a link to the Viz Mosart web server log files. These temporary log files are saved in C:
\Users<username>\AppData\Local\Temp, with names starting with the date they were created, followed by an ID.

To troubleshoot issues, check the following locations for relevant logs:

 Web server logs: By default, these are written to C:\MMLogs\WebServer . The location is configurable 
in the web server configuration file:
C:\ProgramData\Mosart Medialab\Mosart Web Apps\serverSettings.json. Look for 

the NLogConfig  setting.

 Proxy server logs: By default, these are stored at C:\MMLogs\Mosart Web Proxy .
 Windows Event Log: Use the Event Viewer to check for system or application-related errors.
 Browser logs: To view logs in your browser, press Ctrl+Shift+I (this toggles the Developer Tools panel). Do 

this while using the Mosart Web Applications Configuration Tool or any browser with a Mosart web 
application open.
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11.1.1 The Mosart Web Proxy Service is not running or is not functioning properly

Review the settings in

 The Server Configuration page.
 Proxy server logs located by default at C:\MMLogs\Mosart Web Proxy.
 The browser logs. You can investigate your browser logs by typing CTRL+Shift+I (this is a toggle) in the 

Mosart Web Applications Configuration Tool or the browser where a Mosart web application is open.

Start the Mosart Proxy Service in console
If the Mosart Web Proxy service fails to start and there is little information in either the proxy logs or the browser, 
you can start Caddy in the console to troubleshoot the problem using the following command. If this is running as a 
Windows service, stop it first.

C:\Program Files (x86)\Mosart Medialab\Mosart Web Proxy>caddy2.exe run --config "C:
\ProgramData\Mosart Medialab\Mosart Web Apps\Caddyfile"

Typical situations are where Caddy fails to start because the port (default 55142 for HTTP and 55143 for HTTPS) is 
already in use by other applications or the certificate and/or the key files configured are not valid:

11.1.2 The Mosart Web Applications Service is not running or is not functioning 
properly

Review the settings in

 The Server Configuration page.
 Web server related logs written in the Windows Event Log accessible from the error message in the Mosart 

Web Applications Configuration Tool.
 Web server logs written on disk (default location “C:/MMLogs/WebServer“ configurable in the web server 

configuration file, C:\ProgramData\Mosart Medialab\Mosart Web Apps\serverSettings.json - search for setting 
NLogConfig).

 The browser logs. You can investigate the browser logs by typing CTRL+Shift+I (this is a toggle) in the Mosart 
Web Applications Configuration Tool or the browser where a Mosart web application was opened for more 
details.

Copyright © 2025  Vizrt                                                          Page  125



Viz Mosart Web Applications -  2.5

Start the Mosart Web Applications Service in console
If the Mosart Web Applications service fails to start and there is little information in either the web server logs or the 
browser, you can start the service in the console to troubleshoot the problem. If this is running as a Windows 
service, stop it first.

Typical situations are where the web server fails to start because the port (default 65142 for HTTP and 65143 for 
HTTPS) is already in use by other applications or the certificate and/or the key files configured for HTTPS are not 
valid.

11.1.3 The External Proxy Service is unreachable or not functioning properly
Review the settings in

 The Server Configuration page.
 External proxy configurations.
 The web server logs accessible from the error message in the Mosart Web Applications Configuration Tool.
 The browser logs. You can investigate the browser logs by typing CTRL+Shift+I (this is a toggle) in the 

Mosart Web Applications Configuration Tool or the browser where a Mosart web application was opened.

11.1.4 Unable to reach the Viz Mosart Server (main or backup)
Some of the Mosart Web Applications might not function as expected. Ensure that the Mosart Remote Control 
Service (RCS) located on the Viz Mosart server is running. Review the settings in the Server Configuration page, web 
server log file accessible from the error message in the Mosart Web Applications Configuration Tool or the browser 
logs for more details. You can investigate the browser logs by typing CTRL+Shift+I (this is a toggle) in the Mosart 
Web Applications Configuration Tool or the browser where a Mosart web application was opened.

Check the status of the Viz Mosart server
In a browser, paste the URL to the Viz Mosart server status endpoint:

HTTP
http://<mosart-server-host>:55167/status for HTTP

HTTPS
https://<mosart-server-host>:55168/status for HTTPS

Using a Web proxy
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http://<webproxy-url>:55142/mosart/main/status

You should get a result similar with the following (serverDescription is not available in older Mosart versions):

If no response is received:

 Ensure that the Viz Mosart server version is compatible with the Viz Mosart Web Applications. Refer to the 
Release Notes for System Requirements.
or

 Start Mosart Remote Control Service (RCS) as console to investigate further the issue. If the service is 
running as Windows service, stop it first.
Typical situations are where RCS fails to start because the port (default 55167 for HTTP and 55168 for 
HTTPS) is already in use by other applications or the certificate and/or the key files configured for HTTPS are 
not valid:

Note: In the first two examples above, replace <mosart-server-host> with the hostname, IP address or the 
FQDN of your Viz Mosart server.
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Viz Mosart Server version might be incompatible with this version of Viz Mosart Web 
Applications

 Please review the corresponding version Release Notes for product interoperability.

If HTTPS is used, this must be enabled on both Viz Mosart Server and Viz Mosart Web 
Applications

You may get this warning messages because no updates could be retrieved from Viz Mosart server.

 Ensure that the Viz Mosart server version is compatible with the Viz Mosart Web Applications. Refer to the 
latest Release Notes for System Requirements.

 Ensure that HTTPS is used and enabled on both Viz Mosart server and the Viz Mosart Web Applications. 
Check the settings in the Server Configuration page, Viz Mosart web server log file or the browser logs 
(CTRL+Shift+I in the Configuration Tool) for more details.

 Check the status to the Viz Mosart server as described above.

11.1.5 The Web Applications Service is not running
A common offline error occurs when the Windows service fails to start because the port is in use.

 Verify that the Web Applications service port is not in use. The default port is 65142 for HTTP and 65143 for 
HTTPS. The port can only be changed in the configuration file at C:\ProgramData\Mosart Medialab\Mosart 
Web Apps\serverSettings.json.

Note: Any changes to the Viz Mosart web server configuration file (C:\ProgramData\Mosart 
Medialab\Mosart Web Apps\serverSettings.json) are overwritten when you press Save in the Mosart Web 
Applications Configuration Tool.
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 Try restarting the service with the Restart button available in the error message in the Mosart Web 
Applications Configuration Tool.

 Review the settings in the Server Configuration page, web server log file accessible from the error message in 
the Mosart Web Applications Configuration Tool or the browser logs for more details.

11.2 Rundown Viewer and Timing Display Issues
 If you experience the following issues with Rundown Viewer and Timing Display:

 The content loads slowly or only partially.
 You cannot open more than 5-6 web sessions, meaning that opening the web application in multiple 

browser tabs or instances fails after 5-6 clients.

These problems may indicate that HTTPS is not properly configured across all relevant components.

In the screenshot below, the 6th Rundown Viewer client displays an error connecting to the Mosart server, while the 
other clients are functioning correctly:

Troubleshooting Steps:

1. Inspect Browser Logs:
 Open the browser's Developer Tools and go to the Network tab.
 Inspect some of the URLs. For example, you might see a request URL to the Mosart Server like 
http://proxy-server:55142/mosart/mosarthub/negotiate?

name=MosartWebUI&negotiateVersion=1 .
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 A "307 Temporary Redirect" status code indicates that the resource has been temporarily moved to a 
different URL. This suggests that the proxy server (Caddy) has redirected the client to use HTTPS 
instead of the original HTTP request.

2. Understand the issue:
 In this example, the client (the Rundown Viewer in the web browser) initially made a request over 

HTTP to the Mosart server, but the proxy server redirected it to HTTPS.
 This indicates that HTTPS is configured for the Mosart server but not for the Mosart web server and 

the proxy server.
 By default, the Mosart Web Proxy is configured to enforce HTTPS by redirecting HTTP requests to 

HTTPS before they reach the Mosart server, if the Mosart server is set up with HTTPS.
3. Fix the problem:

 To resolve this issue, enable HTTPS for the Mosart web server and the proxy server (internal or 
external) using the Mosart Web Apps Configuration Tool.
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11.3 Issues with Mosart Web Server Connecting to the Mosart Server

11.3.1 Mosart Remote Control Service (RCS)
Issues with Mosart web server connecting to the Mosart Remote Control Service (RCS), may be due to the RCS not 
automatically detecting the fully qualified domain name (FQDN) of the machine where it is installed.

For enhanced security and connection stability between the Mosart web server and the Mosart Remote Control 
Service, the setting SignalRAllowedOrigins is introduced.

This setting allows you to specify an exclusive list of origins that may access the SignalR service (used for 
communication to RCS), ensuring connections are secure and reliable.

1. Navigate to the default location of the RCS configuration file at C:\Program Files (x86)\Mosart 
Medialab\Mosart Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml.

2. Manually configure SignalRAllowedOrigins to include the fully qualified domain name of your Mosart 
server.

11.3.2 Firewall Ports
 Ensure the default ports have access.

11.4 Browser Logs

11.4.1 To investigate browser logs
In failure situations, you can use your web browser to access the Mosart Web Apps directly and further investigate 
the browser logs.

1. In the App Launcher, click on a web app to open it in the default browser, or paste the web app link directly 
into your preferred browser:

a. NRCS Plugin: http(s)://<your-hostname>:<web-proxy-port>/plugin/?nrcs=ENPS&mosid=mosart
b. Rundown Viewer: http(s)://<your-hostname>:<web-proxy-port>/rundown
c. Timing Display: http(s)://<your-hostname>:<web-proxy-port>/timingdisplay/editor
d. Showmaker: http(s)://<your-hostname>:<web-proxy-port>/showmaker/

2. Type CTRL+Shift+I (this is a toggle) in the browser and inspect the Console tab or the Network tab.

Note: For Mosart applications like the Rundown Viewer and Timing Display (which rely on SignalR for real-
time communication), when failure to recognize a FQDN prevents communication to RCS, defining 
SignalRAllowedOrigins is essential.
For detailed configuration instructions, please refer to the RCS configuration file 
(RemoteDispatcherServiceConfig.xml) where inline comments provide explanatory documentation.
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